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Format

I will provide you tools and workflow to get started with R

I will go over specific statistical functions
How to run them

How to interpret the results

We'll have hands-on, lecture, and demonstrations

R is hard: But have no fear!

Don't expect to remember everything!

Copy/Paste is your friend (never apologize for using it!)

Consider these labs a resource to return to

About these Labs
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ImpostR Syndrome
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ImpostR Syndrome

David WhittakerDavid Whittaker

6 / 51



ImpostR Syndrome

David WhittakerDavid Whittaker

Moral of the story? 
Make friends, code in groups, learn together and don't beat yourself up
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About R



R is hard

Why R?
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But R is powerful (and reproducible)!

Why R?
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But R is powerful (and reproducible)!

Why R?
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R is also beautiful

Why R?
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R is affordable (i.e., free!)

Why R?
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What is R?



A programming language is a way to give instructions in order to get a computer to do something

You need to know the language (i.e., the code)

Computers don't know what you mean, only what you type (unfortunately)

Spelling, punctuation, and capitalization all matter!

For example

R, what is 56 times 5.8?

56 * 5.8

## [1] 324.8

R is Programming language
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R, what is the average of numbers 1, 2, 3, 4?

mean(c(1, 2, 3, 4))

## [1] 2.5

Use code to tell R what to do
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R, what is the average of numbers 1, 2, 3, 4?

mean(c(1, 2, 3, 4))

## [1] 2.5

R, save this value for later

steffis_mean <- mean(c(1, 2, 3, 4))

Use code to tell R what to do
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R, what is the average of numbers 1, 2, 3, 4?

mean(c(1, 2, 3, 4))

## [1] 2.5

R, save this value for later

steffis_mean <- mean(c(1, 2, 3, 4))

R, multiply this value by 6

steffis_mean * 6

## [1] 15

Use code to tell R what to do
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Code

The actual commands

Output

The result of running code or a script

Script

A text file full of code that you want to run

You should always keep your code in a script

Code, Output, Scripts
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Code

The actual commands

Output

The result of running code or a script

Script

A text file full of code that you want to run

You should always keep your code in a script

For example:

mean(c(1, 2, 3, 4))

## [1] 2.5

Code, Output, Scripts

Code

Output

Script
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RStudio is not R

RStudio is a User Interface or IDE (integrated development environment)
(i.e., Makes coding simpler)

But sometimes tries to be too helpful

RStudio vs. R

RStudioRStudio RR
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Changing Options: Tools > Global Options
General > Restore RData into workspace at startup (NO!)

General > Save workspace to on exit (NEVER!)

Code > Insert matching parens/quotes (Personal preference)

Projects

Handles working directories

Organizes your work

Packages

Can use the package manager to install packages

Can use the manager to load them as well, but not recommended
Load packages in your script so you remember which ones you used!

RStudio Features
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Set up a Project for this course

Let's take a look at RStudio



Your first real code!



# First load the package
library(tidyverse)

# Now create the figure
ggplot(data = msleep, aes(x = sleep_total, y = sleep_rem, colour = vore)) +
  geom_point()

Copy/paste or type this into the script window in RStudio
You may have to go to File > New File > R Script

Click anywhere on the first line of code

Use the 'Run' button to run this code, or use the short-cut Ctrl-Enter
Repeat until all the code has run

First Code
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# First load the package
library(tidyverse)

# Now create the figure
ggplot(data = msleep, aes(x = sleep_total, y = sleep_rem, colour = vore)) +
  geom_point()

## Warning: Removed 22 rows containing missing values (geom_point).

First Code
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# First load the package
library(tidyverse)

# Now create the figure
ggplot(data = msleep, aes(x = sleep_total, y = sleep_rem, colour = vore)) +
  geom_point()

## Warning: Removed 22 rows containing missing values (geom_point).

First Code

Package
tidyverse
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# First load the package
library(tidyverse)

# Now create the figure
ggplot(data = msleep, aes(x = sleep_total, y = sleep_rem, colour = vore)) +
  geom_point()

## Warning: Removed 22 rows containing missing values (geom_point).

First Code

Functions: 
library(), ggplot()

aes(), and geom_point()
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# First load the package
library(tidyverse)

# Now create the figure
ggplot(data = msleep, aes(x = sleep_total, y = sleep_rem, colour = vore)) +
  geom_point()

## Warning: Removed 22 rows containing missing values (geom_point).

First Code

+ 
(Specific to ggplot)
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# First load the package
library(tidyverse)

# Now create the figure
ggplot(data = msleep, aes(x = sleep_total, y = sleep_rem, colour = vore)) +
  geom_point()

## Warning: Removed 22 rows containing missing values (geom_point).

First Code

Figure!
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# First load the package
library(tidyverse)

# Now create the figure
ggplot(data = msleep, aes(x = sleep_total, y = sleep_rem, colour = vore)) +
  geom_point()

## Warning: Removed 22 rows containing missing values (geom_point).

First Code

Warning
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# First load the package
library(tidyverse)

# Now create the figure
ggplot(data = msleep, aes(x = sleep_total, y = sleep_rem, colour = vore)) +
  geom_point()

## Warning: Removed 22 rows containing missing values (geom_point).

First Code

Comments
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Objects are things in the environment

(Check out the Environment pane in RStudio)

R Basics: Objects



Do things, Return things

Does something but returns nothing
e.g., write_csv() - Saves the mtcars data frame as a csv file

write_csv(mtcars, path = "mtcars.csv")

Does something and returns something
e.g., sd() - returns the standard deviation of a vector

sd(c(4, 10, 21, 55))

## [1] 22.78157

functions()
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Functions can take arguments (think 'options')

data, x, y, colour

ggplot(data = msleep, aes(x = sleep_total, y = sleep_rem, colour = vore)) +
  geom_point()

functions()
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By name:
mean(x = c(1, 5, 10))

## [1] 5.333333

By order:
mean(c(1, 5, 10))

## [1] 5.333333

Functions can take arguments (think 'options')

data, x, y, colour

ggplot(data = msleep, aes(x = sleep_total, y = sleep_rem, colour = vore)) +
  geom_point()

Arguments defined by name or by position

With correct position, do not need to specify by name

functions()
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By name:
mean(x = c(1, 5, 10))

## [1] 5.333333

By order:
mean(c(1, 5, 10))

## [1] 5.333333

Functions can take arguments (think 'options')

data, x, y, colour

ggplot(data = msleep, aes(x = sleep_total, y = sleep_rem, colour = vore)) +
  geom_point()

Arguments defined by name or by position

With correct position, do not need to specify by name

Note that c() is also a function: combine or concatenate

functions()
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By name:
mean(x = c(1, 5, 10, NA), 
     na.rm = TRUE)

## [1] 5.333333

Watch out for 'hidden' arguments

functions()
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By name:
mean(x = c(1, 5, 10, NA), 
     na.rm = TRUE)

## [1] 5.333333

By order:
mean(c(1, 5, 10, NA), 
     TRUE)

## Error in mean.default(c(1, 5, 10, NA), TRUE): 'trim' 
must be numeric of length one

Watch out for 'hidden' arguments

functions()
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By name:
mean(x = c(1, 5, 10, NA), 
     na.rm = TRUE)

## [1] 5.333333

By order:
mean(c(1, 5, 10, NA), 
     TRUE)

## Error in mean.default(c(1, 5, 10, NA), TRUE): 'trim' 
must be numeric of length one

Watch out for 'hidden' arguments

This error states that we've assigned the argument trim to a non-valid argument

Where did trim come from?

functions()
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?mean

Your Turn:

Run this, what happens?

Do you see the trim argument?

R documentation
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Vector (1 dimension)

a <- c("a", "b", "c")
a

## [1] "a" "b" "c"

Data frame (2 dimensions)

d <- data.frame(letters = c("a", "b", "c"),
                numbers = c(1, 2, 3),
                treat = c("control", "control", 
"control"))
d

##   letters numbers   treat
## 1       a       1 control
## 2       b       2 control
## 3       c       3 control

Generally kept in vectors or data.frames/tibbles
These are objects with names (like functions)

We can use <- to assign values to objects (assignment)

Data

rows x columns
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Use c() to create a vector
a <- c("apples", 12, "bananas")

Use x[index] to access part of a vector
a[3] # [1] "bananas"

Vectors contain one type of variable
(Even if you try to make it with more)

class(a) # [1] "character"

Vectors
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Create with data.frame()/tibble()
my_data <- tibble(x = c("s1", "s2", "s3", 
"s4"),
                  y = c(101, 102, 103, 104),
                  z = c("a", "b", "c", "d"))
my_data

## # A tibble: 4 × 3
##   x         y z    
##   <chr> <dbl> <chr>
## 1 s1      101 a    
## 2 s2      102 b    
## 3 s3      103 c    
## 4 s4      104 d

(dbl = "Double" = Computer talk for non-integer number)

Data frames (also tibbles)
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Create with data.frame()/tibble()
my_data <- tibble(x = c("s1", "s2", "s3", 
"s4"),
                  y = c(101, 102, 103, 104),
                  z = c("a", "b", "c", "d"))
my_data

## # A tibble: 4 × 3
##   x         y z    
##   <chr> <dbl> <chr>
## 1 s1      101 a    
## 2 s2      102 b    
## 3 s3      103 c    
## 4 s4      104 d

(dbl = "Double" = Computer talk for non-integer number)

Cols have different types of variables
str(my_data)

## tibble [4 × 3] (S3: tbl_df/tbl/data.frame)
##  $ x: chr [1:4] "s1" "s2" "s3" "s4"
##  $ y: num [1:4] 101 102 103 104
##  $ z: chr [1:4] "a" "b" "c" "d"

Data frames (also tibbles)
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x$colname to pull out column
my_data$x

## [1] "s1" "s2" "s3" "s4"

Or use pull() (from tidyverse)

pull(my_data, x)

## [1] "s1" "s2" "s3" "s4"

Data frames (also tibbles)
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x$colname to pull out column
my_data$x

## [1] "s1" "s2" "s3" "s4"

Or use pull() (from tidyverse)

pull(my_data, x)

## [1] "s1" "s2" "s3" "s4"

x[row, col] to access rows and columns of a

data frame

my_data[1:2, 2:3]

## # A tibble: 2 × 2
##       y z    
##   <dbl> <chr>
## 1   101 a    
## 2   102 b

Data frames (also tibbles)
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1) Create a vector with 5 numbers and look at it
Find it in the "Global Environment" pane (upper right)

Type its name in the console and hit enter

     <- c(  ,  ,  ,  ,  )
    

2) Create a data frame with data.frame() or tibble()
Click on it's name in the "Global Environment"

Type its name in the console and hit enter

     <-          (     = c("  ", "  ", "  "),
                         = c(  ,  ,  ))
    

Your Turn: Vectors and Data frames
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Miscellaneous



R cares about spelling

R is also case sensitive! (Apple is not the same as apple)

Commas are used to separate arguments in functions

For example

This is correct:

mean(c(5, 7, 10))  # [1] 7.333333

This is not correct:

mean(c(5 7 10))

## Error: <text>:1:10: unexpected numeric constant
## 1: mean(c(5 7
##              ^

R has spelling and punctuation
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R cares about spelling

R is also case sensitive! (Apple is not the same as apple)

Commas are used to separate arguments in functions

For example

This is correct:

mean(c(5, 7, 10))  # [1] 7.333333

This is not correct:

mean(c(5 7 10))

## Error: <text>:1:10: unexpected numeric constant
## 1: mean(c(5 7
##              ^

R has spelling and punctuation

>80% of learning R is learning to
troubleshoot
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Spaces usually don't matter unless they change meanings
5>=6    # [1] FALSE
5 >=6   # [1] FALSE
5 >= 6  # [1] FALSE
5 > = 6 # Error: unexpected '=' in "5 > ="

Periods don't matter either, but can be used in the same way as letters
(But for complex programming reasons... don't)

apple.oranges <- "fruit"

R has spelling and punctuation
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Use <- to assign values to objects
a <- "hello"

Use = to set function arguments
mean(x = c(4, 9, 10))

Use == to determine equivalence (logical)
10 == 10 # [1] TRUE
10 == 9  # [1] FALSE

Assignments and Equal signs
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Round brackets: ()
Run functions (even if there are no arguments)

Sys.Date() # Get the Current Date

## [1] "2021-09-27"

Braces/Brackets
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Round brackets: ()
Run functions (even if there are no arguments)

Sys.Date() # Get the Current Date

## [1] "2021-09-27"

Without the (), R spits out information on the function:

Sys.Date

## function () 
## as.Date(as.POSIXlt(Sys.time()))
## <bytecode: 0x55b94f5be1a0>
## <environment: namespace:base>

Braces/Brackets
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Round brackets: ()
Run functions (even if there are no arguments)

Sys.Date() # Get the Current Date

## [1] "2021-09-27"

Without the (), R spits out information on the function:

Sys.Date

## function () 
## as.Date(as.POSIXlt(Sys.time()))
## <bytecode: 0x55b94f5be1a0>
## <environment: namespace:base>

Braces/Brackets

() must be associated with a function 
(Well, almost always)
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Square brackets: []
Extract parts of objects

LETTERS

##  [1] "A" "B" "C" "D" "E" "F" "G" "H" "I" "J" "K" "L" "M" "N" "O" "P" "Q" "R" "S"
## [20] "T" "U" "V" "W" "X" "Y" "Z"

LETTERS[1]

## [1] "A"

LETTERS[26]

## [1] "Z"

Braces/Brackets
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Square brackets: []
Extract parts of objects

LETTERS

##  [1] "A" "B" "C" "D" "E" "F" "G" "H" "I" "J" "K" "L" "M" "N" "O" "P" "Q" "R" "S"
## [20] "T" "U" "V" "W" "X" "Y" "Z"

LETTERS[1]

## [1] "A"

LETTERS[26]

## [1] "Z"

Braces/Brackets

[] have to be associated with an object
that has dimensions

(Always)
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Use spaces like you would in sentences:
a <- mean(c(4, 10, 13))

is easier to read than

a<-mean(c(4,10,13))

(But they are equivalent, coding-wise)

Improving code readability
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Don't be afraid to use line breaks ('Enters') to make the code more readable
a <- data.frame(exp = c("A", "B", "A", "B", "A", "B"), 
                sub = c("A1", "A1", "A2", "A2", "A3", "A3"), 
                res = c(10, 12, 45, 12, 12, 13))

vs.

a <- data.frame(exp = c("A", "B", "A", "B", "A", "B"), sub = c("A1", "A1", "A2", "A2", "A3", "A3"), 
res = c(10, 12, 45, 12, 12, 13))

Improving code readability
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Reproducible research



Remembering what you've done (and sharing)

Keep scripts

Annotate scripts (use comments)

Date scripts!

Compile scripts into reports or notebooks

Include version information
devtools::session_info()

What is reproducible research?

We can use the "Compile Report" button in
RStudio to create an HTML report of your

work
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tidyverse?



R base

R base is basic R

Most packages used are installed and loaded by default

R base vs. tidyverse
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R base

R base is basic R

Most packages used are installed and loaded by default

tidyverse
Collection of 'new' packages developed by a team closely affiliated with RStudio

Packages designed to work well together

Use a slightly different syntax

Among others, includes packages used for data transformations and visualizations:
e.g., ggplot2, dplyr, tidyr

R base vs. tidyverse
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R base

R base is basic R

Most packages used are installed and loaded by default

tidyverse
Collection of 'new' packages developed by a team closely affiliated with RStudio

Packages designed to work well together

Use a slightly different syntax

Among others, includes packages used for data transformations and visualizations:
e.g., ggplot2, dplyr, tidyr

Can be helpful to understand whether functions are tidyverse or R base functions

R base vs. tidyverse
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http://www.cookbook-r.com

R for Data Science

R base cheatsheet

Wrapping up: Further reading
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http://www.cookbook-r.com/
http://r4ds.had.co.nz/
https://www.rstudio.com/wp-content/uploads/2016/05/base-r.pdf

